
GIS Exercises  Lab 9: Buffering and Overlay

LAB 9: Buffering and Overlay in QGIS 

What You’ll Learn: to apply the concepts of buffering and overlay, two common 
cartographic operations. You should read the sections on buffering and overlay in 
Chapter 9 in the GIS Fundamentals textbook. 

Data: All data are in \L9 subdirectory, including lakes.shp, roads.shp, and public lands in 
public_Hugo.shp.  All distance units are meters.  

What You’ll Produce: Two maps, of 1) lake buffers,  and 2) suitable recreation areas 
on private land. 

Part 1: Buffering in QGIS 
Create a new QGIS project and add the 
roads.shp data layer.   

Left click Vector on the top tool bar and 
then Geoprocessing Tools -> Buffer. 
(Video: Buffer) 
 

There are options to specify the input 
feature layer, the buffer distance and 
units, and the output. 

Specify “Dissolve results” because 
otherwise the tool generates multiple, 
overlapping polygons. 

Use the parameters shown at left and 
add the result to your project when 
finished. 
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The buffer layer should look 
something like that on the right, 
here re-arranged to show the roads 
on top, and the buffer in purple 
below. 

Redo this buffer, but this time; 
leave the default Dissolve buffer 
results UNCHECKED.  Make sure 
to open and view the attribute table 
associated with each buffer layer. 

How do the results differ?  When 
would this be important? After 
inspecting, remove the undissolved 
layer. 

Creating a Variable Distance Buffer 
The second exercise will buffer the Lakes.shp layer using a variable distance buffer 
(Video: Variable Distance Buffer).   

The buffer distances are: 
° A buffer distance of 50 meters for lakes with size class 1 
° A buffer distance of 150 meters for lakes with size class 2 
° A buffer distance of 500 meters for lakes with size class 3 

There are three main steps: 
- Open the lakes attribute table and insert a field to hold the variable buffer distance. 
- Select by Attributes to assign values for the variable buffer distance (refer to Labs 7 

and 8 if you don’t remember the details on selecting and editing values in a table). 
- Apply the buffer operation. 

For this exercise, specifically you should: 
° Make sure the Lakes.shp is in your project, and open its attribute table. You may 

manually select by sorting/shift clicking, or by using a selection condition to select 
the lakes with size class 1. 

° Toggle Edit, and use the Field Calculator to create a new whole number (integer) 
field named something like buffdist, with a value of 50.  
Make sure that you have the option checked for only updating selected features, 
near the upper left of the tool.  Apply the calculation.   

° Select those features with Size_CLS of 2, and use the Field Calculator to Update an 
Existing Field, assigning 150 to the buffdist variable. 

° Repeat the select/assign process for lakes with Size_CLS 3, assigning a buffdist of 
500.  
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° Unselect any selected polygons or the buffer will only be applied to those selected 
(e.g., before switching out of the table, click on the Unselect all to clear the selected 
features. If you forget here, you can unselect from the main QGIS menu).  Save your 
edits and toggled off editing mode. 

Check that your table is correct, e.g., similar to the example figure below.  Note that the 
last two columns, SIZE_CLS and buffdist, change in concert, with a larger buffer 
distance appearing for larger size classes. 
 

Now create the variable distance buffer (read the section on variable distance buffers in 
Chapter 9 in the text if you aren’t sure of this concept). 

Use the same buffer tool as we introduced previously (Vector->Geoprocessing->Buffer). 

Specify the same input data layer as before, Lakes.shp, and also make sure to click the 
check box to Dissolve the result (figure below). 
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We specify a variable distance buffer through an option box, accessed by clicking on a 
small box at the far right of the distance/units option (see arrow below). 

This allows us to open a sequence of dropdowns, here we choose field, and then 
buffdist as the variable that contains the buffer distance (see figure below). 

 

 
We may specify an output, something 
like VarBuffLakes, and run the tool. 

This should create a layer similar to 
that at right.  Note the buffers are larger 
for the larger lakes, as per our 
specified buffer distance variable. 

Arrange the roads, dissolved fixed 
distance road buffer, lakes, and 
variable distance lake buffer layers so 
that you can see all three, as in the 
figure below.  

Create and export a layout with the 
roads, lakes, and their buffers, as in the 
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view shown here.  Make sure the order is as shown here, so you may see most of each 
layer. The order is, from the top, 1) roads, 2) road buffer, 3) lakes, 4) lake buffer. 

Your data view should look something like the figure below.  

Create a layout with the four data layers as below, and label each layer with descriptive 
text in the TOC/legend, and include a scale bar, north arrow, and title.  
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Part Two: Overlay in QGIS 
Our goal in this exercise is to find potential campgrounds for a State Park.  A 
campground needs to be close to lakes.  However, these will be drive in sites that must 
also be close roads.  The final map will show locations that are both within 50, 150 or 
500 meters of a lake (depending on the size of the lake) and within 300 meters of a 
road. 
  
We have already created our starting Layers.  These are the variable distance lakes 
buffer and the fixed distance roads buffer from the previous exercises.   

Here we need to modify input layers prior to overlay so that we may easily interpret the 
results after overlay.  

First, we must turn the buffer output to single part features.  Buffer returns multipart 
features, which means there may be multiple polygons for a single row. 

Open the attribute table for VarBuffLake, you should see just one row, while the layer 
obviously has many polygons. 
 
To convert this multipart layer to 
single parts, use 

Vector->Geometry Tools-> 
Multipart to Singleparts 

The tool window isn’t shown, 
because it is rather simple, with 
an input and output file. 

After running the tool, open the table for the output.  Note that there are now multiple 
entries, one for each polygon. 

Also note that the buffdist is now wrong, it has a value of 50 for all the polygons (or 
perhaps one of the other values, 150 or 500 is repeated, the one it saves appears 
somewhat random), even though the medium and large sized lakes had different buffer 
distances. That’s because the individual data are lost, and buffer only records the 
values for one polygon in the multipart feature.  It copies those values to the singlepart 
features you create, but they’re usually not relevant or correct for all individual polygons. 
In this case, we don’t need the buffdist variable any more, so we could delete it.  

You should also delete the now all irrelevant other columns, like Lakes_, Lakes_ID, 
Acres, SIZE_CLS, and buffdist, as they are only correct for one of the polygons, and not 
the other 26. 
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Our overall goals require we identify areas that are inside the lake buffers. We create a 
new item (column) in the lakes buffer table (here insd_lbuf), with a value of 1 for all the 
lake buffer polygons. 

Refer to previous labs if you forget how to 
add a column. When you are done, you 
should have an attribute table for the lakes 
buffer that looks similar to the figure at right.  

Do the same for the road buffer layer.  Add a 
new attribute named something like 
insd_rbuf, and assign it a value of 1 to 
indicate it is inside the road buffer.    

Remember to save and toggle off editing for 
each layer when complete. 

We don’t worry about assigning a value for 
areas outside of buffers because of the way a vector data model views the vector world.  
Areas outside of polygons do not have a boundary nor a record in the attribute table 
associated with them. We cannot assign a value for these “outside” areas in each input 
layer, because there is nothing to attach the value to.  

Before we overlay the two layers with the “Union” command, we need one more 
preparation step.  The lake buffers layer we created has buffered areas that include the 
lake as well as the land near shore. Campsites will be on dry ground, so we will use the 
Difference tool to remove the lake from the lake buffer layer.  

Open the VectoràGeoprocessing Toolsà Difference 
° Specify Input Vector Layer as the variable lakes buffer layer 
° Specify the Difference Layer as the lakes layer 
° Set the output destination to something like LakeBuffOnly.shp 
° Run,  

 
Display the output and verify that the results are the lakes buffer 
layer with the lakes area removed, something that looks like a 
bunch of moth-eaten blobs (here is a portion of the correct 
output): 
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Now to overlay the two buffer layers, using the Union command (Video: Union).   

° Select VectoràGeoprocessingTools à Union  
° Specify the input layers – LakesBuffOnly and rdbuff_SP, 
° Specify the output layer  something like buffs_union, and Run. 
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Examine the “unioned” layer and open the attribute table for this layer.  Use 
the manual selection tool (icon at right, usually found near the tope-center of 
the main QGIS frame) and click in a polygons that meets both the within the 
roads buffer and the within the lakes buffer criteria (see the figure below for 
an example). 

The selected polygon meets both the road proximity and lake proximity criteria, that is, 
the table entry shows both the insd_rdbuf and insd_lbuf are equal to 1. 

Note that there also appear to be multiple, distinct polygons linked to this row. 

QGIS groups polygons in the data files when performing analysis.  When we are 
finished with our analysis we will “ungroup” polygons in the file, creating a table row for 
each polygon.  

Open the attribute table for the overlain file (I named mine buffs_union.shp).  
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Click on the filter/select using form button, on top of the table towards the right: 

This should open a form window, with the parameter entry portion as shown below. 

Originally, all the buttons on the right are set to exclude field.  

I can click on the caret at the right end of each button, and change its operation by 
clicking in the appropriate check box, here  “Equal to (=) for insd_lbuf: 

 

Above, I’ve specified the filter to 
select polygons with the  

insd_lbuf = 1 and the  

insd_rdbuf = 1.   

When I click on the select 
features button near the bottom 
right of the filter tool, 

 

it yields the selection on the 
right. 

On visual inspection, these are 
the polygons within both the 
road and lake buffers. 

 !  10



GIS Exercises  Lab 9: Buffering and Overlay

Close the attribute table, and with the polygons above still selected, export these to a 
new shapefile (remember, in the Layers/TOC,  

o right click on the buffs_union, then  
o Export -> Save selected features… 

Display the data, and verify you have 
something like that on the right: 

Use the manual selection tool, and 
verify that some of these are still 
multipart, by clicking on a few 
polygons.  

Convert the multiparts to single parts  
(Select Vectorà Geometry Tools à  
Multipart to singleparts).  

We have one final criteria to meet, that these campgrounds be on private land.  

We have a digital layer of public land, in the Public.shp layer. 

 Do you remember a tool we used earlier in this lab to remove a portion of an existing 
layer? 

If you don’t remember, look above, find the appropriate tool, and use the tool along with 
the Public.shp data layer and singlepart Road_Lakes buffer (mine was named 
RdLks_Only_SP) to create your final layer. 

The westernmost lakes should look like the figure here, with 
the public bits carved out of the lower lake: 

Create a Layout that includes roads, lakes, and lands 
suitable for campgrounds on private land.  (see below) 

Label each layer with descriptive text in the legend, and 
include a scale bar, north arrow, and title.  

Export a pdf of your map.
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!
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